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AC2950 AutoCAD and SketchBook Designer offer interoperability tools that allow you to take 

AutoCAD geometry to SketchBook Designer for illustration. The finished DWG™ file can be 
brought back into AutoCAD to be shared in plots or through DWF™ files. In this hands-on 
lab, you will discover creation, editing, and shading tools. You will explore layer 
management. You will also learn about the various configurations of the SketchBook 
Designer add-in for AutoCAD and how to create and manage canvases in AutoCAD. 
Enhance your next AutoCAD design presentation with the tools available from the 
Autodesk Design Suites. 

 
 

Learning Objectives 
At the end of this class, you will be able to: 

 Discover creation, editing, and shading tools and explore layer management. 

 Explore the various configurations of the SketchBook Designer add-in for AutoCAD. 

 Enhance AutoCAD design presentations with the tools available from Autodesk® Product Design 
Suite. 

 Create and manage SketchBook Designer canvases within AutoCAD. 

 

 

 

 

About the Speaker 

Jerry is an Applications Engineer for EMA Design Automation, Inc.  He is involved with Pre-

Sales and Post-Sales implementation, installation, configuration, education, and 

standardization of the Autodesk manufacturing products. Jerry has worked at engineering firms 

and Autodesk VARS, using and supporting Autodesk products since 1985. 
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Introduction 
Autodesk® SketchBook® Designer 2014 software enables you to explore design concepts and 

produce stunning artwork. It offers a hybrid paint and vector workflow to give creative 

professionals the functionality they need to quickly transform ideas into compelling design 

iterations and visual communications. 

With the interoperability introduced in AutoCAD 2012, the “connected” workflow allows 

designers to transfer geometry and images to SketchBook Designer. Create, edit, shade or 

annotate the design. Generate images from SketchBook Designer or return the illustration back 

to AutoCAD for communication with clients and stakeholders. 

 
 Image by Jerry Berns 

    
 Images courtesy of Autodesk, Inc. 

General Workflow 
This class will focus on the SketchBook Designer Add-in for AutoCAD and the workflow options 

in which canvases are created in AutoCAD first. A designer could optionally begin a drawing in 

SketchBook Designer and then open it in AutoCAD. Less control is offered with the latter 

method and it would seem to require more steps to configure the canvases. 

A series of exercises will demostrate creating canvases, optional underlays, opening 

SketchBook Designer to illustrate the model and finally returning the drawing to AutoCAD. 

Please note this document is not intended to describe all the tools and workflows available in SketchBook 

Designer 2014. Consult the SketchBook Designer help system for additional information. 
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A common workflow to include SketchBook imagery in an AutoCAD drawing is as follows: 

1. Create a canvas on an AutoCAD 

layout. 

 

2. Use Ribbon tools or grips to set 

canvas size and position. 

 

3. Use Ribbon tools to control 

resolution, underlays, and 

transparency.  

4. Apply canvas. 

 

5. Open SketchBook Designer. 

 

6. Convert any underlay layers to 

paint or vector layers as needed.  

7. Create additional vector or paint 

layers as needed. 
  

8. Complete the sketch.  

9. Return to AutoCAD. 
 

 

 

 

 

For the purpose of brevity, the term SBD will often be used in place of 

SketchBook Designer. 
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Create and Manage Canvases 
Canvas management is controlled from the SketchBook Designer panels. 

 

These canvases can be created in Model Space or Paper Space. Multiple canvases can be 

created. Each will become a page within the SBD environment. For clarity, the Model Space 

image below was configured with a light-gray background. 

           

AutoCAD objects (with the exception of dimensions, text, annotations, and solids) that fall within 

the boundary of a canvas can be converted to an underlay. With Create Vector Underlay OFF 

and Create Paint Underlay OFF, no objects or images will be converted for transfer to 

SketchBook Designer. 
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Vector Underlays 
Selecting Create Vector Underlay ON in the Vector Underlay panel will convert objects within 

the canvas boundary into vector objects that will appear when opened in SBD. 

  

  

To control layer conversion from AutoCAD to SBD, toggle the layer control on the Vector 

Underlay panel. 

 

Preserve Layers 
The AutoCAD object layers will have a matching 

vector layer in SBD. 

Merge Into Single Layer 
All geometry will be merged into a single vector 

layer in SBD. 

 

  



  6 

If working with a 3D model, toggle the display style to control appearance in SBD 

  

2D Wireframe 
Create a wireframe sketch of the 3D 

model. 

 

Hidden 
Create a hidden-view sketch of the 3D 

model. 

 

 

Paint Underlays 
Selecting Create Paint Underlay ON will convert objects within the canvas boundary into paint 

objects that will appear when opened in SBD. Use this method if you do not need to manipulate 

the objects as vectors in SBD. Upon selecting the Apply button, AutoCAD will “plot” the canvas 

to create an image for transfer to SBD. 

      

Portfolio Tool 
The Portfolio tool allows the designer to name, place or delete a canvas. A canvas is 

similar to a block. Deleting an occurrence from a layout does not remove it from the 

drawing. It can be placed again on the same or a different layout. 

Select a canvas on the palette then select the command from the menu at the 

top of the palette. Optionally, select a command from the Marking Menu shown 

to the left. 

A final command available from the Portfolio palette is the ability to export a 

canvas as an image. This is a convenient way to create images without having 

to return to SBD to use its export tool.  
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Exercise 1 – New Canvas  

The following exercise will have you create, select and edit a canvas using a vector underlay. 

Create a new canvas on a layout 

1. Launch AutoCAD. 

2. Open 01 – New Canvas.dwg 

3. Select Layout1. 

4. Make the Objects layer current. 

 

For more convenient layer switching, add the 

Layer drop-down menu to the Quick access 

tool bar.  

5. Draw a few lines, arcs, or circles. 

6. Select the SketchBook Designer tab from the Ribbon. 

7. Make the Canvas layer current. 

 

Use TFRAMES (Toggle Frames) to toggle the visibility of the canvas 

frame prior to plotting. 

 

8. Select New Canvas from the Ribbon. 

9. Set the following values: 

a. Resolution = 96 

b. Create Vector Underlay ON 

c. Preserve Layers 

d. Create Paint Underlay OFF 

e. Transparent = Enable (checked) 

10. Select Apply.  

 

11. Double-click outside the canvas to deactivate it. 
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12. Toggle the canvas layer off and then back on. 

13. Open the Portfolio palette to see the canvas created. 

Select and Edit a canvas 

1. Double-click inside the canvas to activate it. Optionally, use the Select Canvas tool. 

2. Select the Edit Canvas tool. 

 

3. Use the grips to change the size of the canvas. Optionally, toggle between Free or Fixed 

ratio to control aspect. 

4. Apply to save the changes. 

5. Double-click outside the canvas to deactivate. 

Delete and Place a canvas 

1. Use the Erase command or Delete key to erase the canvas. 

2. Use the Portfolio tool to confirm the canvas still exists in the drawing. 

 

3. Select Layout2. 

4. Make the Canvas layer current. 

5. Use the Place Canvas tool from the Portfolio palette to insert the canvas. Follow the 

screen prompts to select the canvas corner points. The canvas should appear active. 

  

6. Close the drawing. No save required. 
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Exercise 2 – New Canvas from Image  

The following exercise will create a new canvas from an image. 

Create a new canvas on a layout 

1. Launch AutoCAD. 

2. Open 02 – New Canvas from Image.dwg 

3. Select Layout1. 

4. Make the Canvas layer current. 

5. From the Canvases drop-down panel, select New Canvas from Image. 

   

6. Select Chicago_skyline.jpg from the Exercises folder.   Change file type to JPG 

7. Select the corner points for the canvas. 

8. A new canvas should appear containing the selected image. 

 

9. The canvas should also be listed in the Portfolio palette. 

 

10. Practice canvas editing such as sizing, 

positioning and rotating. 

11. Close the drawing. No save required.   

Also can use Properties 

Palette to adjust canvas. 
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SketchBook Designer Add-in Tool 
Once the canvas or canvases have been prepared in AutoCAD, the canvases can be 

transferred or opened in SBD. To determine which canvas will be active in SBD, 

activate it by double-clicking the mouse within the canvas boundary then select the 

SketchBook Designer tool from the Ribbon. 

 
 

In this example, the upper right canvas is active (bold, blue border). 

This will become the active page in SBD.  

 

Note: All canvases from all spaces will be available in SBD. Within SBD 

use the Page Manager (Alt + S shortcut) to select a canvas. 

Double-click the page title to rename the page (canvas). 

Use the Page Marking Menu to add, delete or 

duplicate a page.  

 

 

 

 

Canvases behave similar to AutoCAD viewports. Deactivate a canvas in order 

to move, copy or rotate a canvas. 

 

Exercise 3 – Connect to SketchBook Designer  

The following exercise will demonstrate connecting to SBD from AutoCAD using the add-in tool. 

1. Launch AutoCAD. 

2. Open 03 - Bracket.dwg. 

3. Activate the canvas on the Model tab. 
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4. Select the SketchBook Designer tool from the Ribbon. 

 

5. In a moment, SketchBook Designer should appear with the selected canvas. 

 

6. The Create Vector Underlay ON option was selected along with the Preserve Layers 

option. This resulted in the AutoCAD layers being available in SBD. The Convert to 

vector layer tool was used to convert the AutoCAD layers to SBD Vector layers as 

shown in the image below. 

 

7. Select Return to AutoCAD from the SBD toolbar. 

 

8. SBD closes and AutoCAD is activated. 

 

While SBD is active, no AutoCAD commands can be performed. SBD must 

be closed to enable AutoCAD operations again. 

 

9. Close the drawing. No save required. 
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Sketchbook Designer Tools 

Interface 
The SketchBook Designer interface includes toolbars, editors and palettes.  

 

 

Use the Window menu to control the visibility of each of these 

elements. 

The element shortcuts are listed in the menu and Help system.  

  

    

 

Use Tab to toggle visibility of interface elements. 

Use Alt+2 to restore the interface elements to a default 

layout. 

Vector Toolbar 
Selecting a vector layer will activate the Vector toolbar. Selectors, brushes, text, curve editors, 

stroke editors, fill tools, transformation tools, palette toggles, and grid controls are available. 
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Paint Toolbar 
Selecting a paint layer will activate the Paint toolbar. Selectors, brushes, raster editors, fill tools, 

transformation tools, palette toggles, and grid controls are available. 

 

Layer Manager and Marking Menu 
The Layer Manager is essential to the organization and appearance of the illustration. The order 

of the layers in the manager also effects the illustration. Use the Marking Menu over a layer to 

create, clear, delete, duplicate, or merge layers. If you have several layers to manage, create a 

layer folder to provide improved organization.  

 

 

 

1 Show/Hide Layer Manager 

2 Preview Window 

3 Show/Hide Mask section 

4 Toggle layer visibility 

5 Lock a layer to prevent editing  

6 Layer name 

7 Layer Properties tab 

8 Close Layer Manager 

9 Collapse/Expand section 

10 Rearrange layer tool 

11 Layer Marking Menu

Exercise 4 – SBD Interface  

The following exercise will explore the SBD interface.  (SBD Tour Guide – Pages 1-4) 

1. Launch SketchBook Designer. 

2. Open 04 – SBD Interface.dwg. 

3. Press Tab to hide the interface elements. Press Tab again to restore elements. 

4. Press Alt + 2 to restore the default interface elements. 
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5. From the Help Menu, select Tour Guide. 

6. Browse through the pages. Close the Tour Guide window. 

7. Select Paint 1 layer from the Layer manager.      

Note the Toolbar options. 

8. Select Vector 1 layer from the Layer manager.      

Note the Toolbar options. 

9. Press and hold Spacebar to momentarily display the Navigation puck. 

Zoom       Pan       Rotate   

10. Position the cursor as needed over the puck element. Left-click and drag to zoom, pan, 

and rotate. Release the Spacebar. 

 

Roll the mouse wheel to zoom. 

Hold the mouse wheel to pan. 

 

11. From the navigation toolbar, select Fit to view to see the entire page. 

 

This does not rotate the page back to a normal 

orientation. Use the Rotate  tool as needed. 

12. Select the Pencil tool.      

13. Select the Curve stroke tool.      

14. Left-click, drag, and release to create a stroke.  

15. Press and hold B (brush) to momentarily display the Brush size/intensity controls. 

 

16. Left-click and drag right to increase brush size. Release the B key.  

Note the change in the Stroke Editor 

17. Create another curve stroke. 

18. Use the B (brush) key again to change the size/intensity. 

19. Create another curve stroke. 

20. Close the drawing. No save required. 
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Exercise 5 – SBD Brushes and Cycle Manipulator  

The following exercise will explore the various vector and paint brush tools. The Cycle 

Manipulator is useful for refining a curve stroke to a desired shape.  (SBD Tour Guide – Page 9) 

1. Launch SketchBook Designer. 

2. Open 05 – SBD Brushes.dwg. 

3. Select the Vector 1 layer. 

4. Select the Pencil tool, Curve stroke mode. 

5. Create a curve as shown. Note the appearance of the Cycle Manipulator 

 

6. Click the Manipulator several times to cycle through the stroke options. Depending on 

how the curve was created, you may see an elliptical arc, an arc, and a straight line. 

7. Click-drag the circular manipulator to refine the curve.   

8. To accept the stroke, press Enter or just create another curve. 

9. Create an elliptical curve as shown. 

 

10. Cycle through the options. You may see an ellipse or circle dependent on the curve 

stroke original shape. 

11. Create a sketch as shown. 

 

12. Explore the cycle options again using the Manipulator. You may see a straight line or arc 

dependent on the curve stroke original shape. 

13. Explore the other curve options. 

 

  

Ctrl + Left-click drag to select a curve option from the Desktop 

Marking Menu. 

 

14. Close the drawing. No save required. 
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Exercise 6 – SBD Curve Edit 

The following exercise will explore the vector curve edit tools.  (SBD Tour Guide – Page 5) 

1. Launch SketchBook Designer 

2. Open 06 – SBD Curve Edit.dwg. 

 

3. Use Select curve (V) tool to select a curve. Hold Shift to select multiple curves.  

 curves selected from left geometry 

 

Drag a window to select multiple curves. Dragging to the left or right makes no 

difference, any curve inside or crossing the window will be selected. 

 

4. Left-click in an empty area or press ESC to release the selection. 

5. Use Select curve segment (A) tool to select a portion of a curve. Hold Shift to select 

multiple curves. The tool can select middle or tail portions of a curve. 

 segments selected from middle geometry 

6. Press Delete to erase the curve segments. 

7. Use Select curve segment tails (Shift + A) tool to select portions of a curve. Hold Shift 

to select multiple curves. This tool can only select tail portions of a curve. 

  segments selected from right geometry 
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8. Press Delete to erase the curve segment tails. 

 

9. Close the drawing. No save required. 

 

Exercise 7 – SBD Transform and Warping  

The following exercise will explore the transformation and warping tools. The drawing uses 

multiple pages (canvases).  (SBD Tour Guide – Page 6) 

Move, Scale, and Flip Objects 

1. Launch SketchBook Designer. 

2. Open 07 – SBD Transform & Warping.dwg. 

 

3. Select the Vector 1 layer. Page 1 (canvas) should be active. 

4. Select the Move tool. Having selected the layer in the previous step, all objects on the 

layer are selected. The Move Manipulator appears along with a box around the objects. 

   

5. Move the objects along a single axis using an Axis Arrow.      

6. Scale the objects proportionally using the Proportional Scale Arrow.      
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7. Scale along a single axis using the Axis Scale Grip.      

8. Scale the objects disproportionally using a Bounding Box Grip.      

9. Flip the objects using a Flip Arrow.      

10. Rotate the objects using the Rotate Grip.      

 

  

Drag the ring on the Move Manipulator to change the base point for 

scaling, rotating, and flipping. 

 

Distort Objects 

1. Select Page 2 from the Page Manager (2012 only). For 2014 use Page Menu, Previous. 

 

2. Select Vector 1 layer. 

3. Select the Distort tool. The objects on the layer are selected. The Distort Manipulator 

appears. Note a new grip at the center and the corner grips are now diamond-shaped. 
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4. Drag the Bias (Center) Grip to distort the objects.      

  

5. Drag a Corner Grip to distort the objects using the bounding box method. 

  

 

Warp Objects 

1. Select Page 3 from the Page Manager (2012 only). For 2014 use Page Menu, Previous.. 

 

2. Select Vector 1 layer. 
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3. Select the Warp tool. The objects on the layer are selected. The Warp Manipulator 

appears. Note the bounding box grips are now round. 

   

4. Add a bounding box grip to an edge then drag it to warp the objects. 

   

5. Add additional warp grips to warp the objects. 

 

6. Close the drawing. No save required. 
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Exercise 8 – SBD Fills  

The following exercise will explore the various fill tools. Options include solid, linear, radial, and 

texture. (SBD Tour Guide – Page 7) 

1. Launch SketchBook Designer. 

2. Open 08 – SBD Fills.dwg. 

 

3. Select the Solid fill tool. Place the cursor inside the left closed region. The perimeter will 

highlight to indicate a valid fill region.  

  

4. Left-click to fill the region. Double-click the color chip to change the fill color. 

 

5. Select the Linear fill tool. Place the cursor inside the right closed region. 
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6. Left-click and drag to control the linear fill appearance. Double-click a color chip to set a 

color. Click along the central curve to add color chips. Drag the bounding box grips to 

distort the fill. Click the bounding box edges to add grips. 

  

7. Select the Radial fill tool. Place the cursor inside the right closed region and left click. 

Use similar techniques as the Linear fill to manipulate the fill appearance. 

  

 

It is not necessary to erase an existing fill. SBD will replace the existing fill 

with the new fill. 

 

8. Select the Texture fill tool. Select the Import… button on the Texture Palette (Attribute 

Editor). Select Diamond plate.bmp from the Exercises folder. 
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9. Place the cursor inside the left closed region. Left-click and drag to suit. 

  

10. Use similar techniques as the Linear fill to manipulate the fill appearance. Optionally, use 

the Texture palette to adjust Repeat and Flip settings. 

11. Use the Select curve (V) tool to adjust the curve objects. 

a. Drag a curve endpoint to make a region smaller. 

b. Drag a curve endpoint to open a region. 

c. Drag the curve endpoint to reclose the region. 

d. Add grips along a curve and drag the curve to alter its shape. 

 

12. Close the drawing. No save required. 

 

Exercise 9 – SBD Symmetry  

The following exercise will explore the symmetry tool. You can create a simple mirror image or a 

radial pattern. (SBD Tour Guide – Page 13) 

1. Launch SketchBook Designer. 

2. Open 09 – SBD Symmetry.dwg. 
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3. Select Mouse layer. Select the Properties flyout arrow. Enable Symmetry. Close the 

Properties window. 

   

4. Drag the Symmetry Manipulator to create a mirror image of the mouse. The original 

should be in the non-shaded area. Close (X) the manipulator to accept the symmetry. 

     

5. A small symmetry indicator will appear. Select it to open the manipulator if adjustments 

are required. 

 

6. Select Car layer. Enable visibility. Enable symmetry. 
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7. Use the Rotate grip of the Symmetry Manipulator to rotate the symmetry horizontal with 

the shaded portion on the bottom. Use the Move grip to adjust. Close the manipulator. 

   

 

Because the Mouse objects were on a separate layer, they are unaffected 

by the symmetry settings of the Car layer. 

 

8. Select Turbine layer. Enable visibility. Enable symmetry. 

 

9. Rotate and position the manipulator to a setting approximately as shown. 

   
10.  Drag the radial symmetry grip (M) to adjust the quantity. A value of six is shown below. 

   

11. Drag the symmetry position to obtain different results. 

12. Close the manipulator. 
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13. Use the Select curve (V) tool to adjust the shape of the original blade. Optionally add a 

fill pattern in the blade. 

14. Select the Car layer to add another taillight. 

15. Select the Mouse layer to add features. 

 

16. Close the drawing. No save required. 
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Illustrating with SketchBook Designer 
The applications for SketchBook Designer are limitless. This section will provide basic 

illustration examples. 

Exercise 10 – Roller Coaster Guide  

The following exercise will have you illustrate a mechanical assembly. Objects have been 

created in AutoCAD which will be used for vector underlays. 

 

Create the canvas and open in SBD 

1. Launch AutoCAD. 

2. Open 10 - Upper Lateral Guide Asmb - Start.dwg. 

 

3. Select Layout1. 

4. Make the Canvas layer current. 

5. Use New Canvas, set the following values: 

a. Resolution = 96 

b. Create Vector Underlay ON 

c. Preserve Layers 

d. Create Paint Underlay OFF 

e. Enable Transparent 

 

6. Select Apply. 
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7. Select SketchBook Designer. 

NOTE:  SketchBook Designer should open along with the AutoCAD geometry. 

   

Convert AutoCAD geometry to SketchBook geometry for editing 

1. Select the Wheel layer. Note its gray shaded appearance – geometry cannot be edited.  

 

2. Select Convert to vector layer. 

   

NOTE: The layer appearance updates in the Layer Manager and new vector tools are available. 

3. Repeat the vector layer conversion for Swingarm1 and Swingarm2 layers. 

 

Create the Damper component 

1. Create the Damper layer using the New vector layer tool. 
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2. Select Pen brush. Select Rectangle. Select Black color. Sketch two rectangles as 

shown. Zoom as needed. 

  

3. Fit to View    

Color Swingarm1 component using Fill Tools 

1. Select the Swingarm1 layer.  

2. Select Linear Fill.  

3. Select White from the Ramps asset collection.  

4. Click and drag as shown. 

 

5. Adjust the fill to suit. 

6. Press ENTER to accept. 

7. Repeat for the lower right section of Swingarm1. 

Color Swingarm2 component using Fill Tools 

1. Select the Swingarm2 layer. 

2. Select Linear Fill. 

3. Select White from the Ramps asset collection. 
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4. Click and drag as shown. 

 

5. Adjust the fill to suit. 

6. Press ENTER to accept 

Color Wheel components 

1. Select the Wheel layer. 

2. Select Linear Fill. 

3. Select Red Gloss from the Ramps asset collection.    

4. Select an area within the left wheel then drag to suit. 

5. Press ENTER. 

6. Repeat for the second wheel. 

 

Color Damper component 

1. Zoom in on the damper component. 

2. Select the Damper layer. 

3. Select Linear Fill. 

4. Select Black Mat from the Ramps asset collection.    
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5. Select an area near the top of the cylinder then drag down to fill. Adjust to suit. 

 

6. Press ENTER. 

7. Select Grey Gloss from the Ramps asset collection.    

8. Select an area near the top of the piston then drag and adjust to suit. 

 

9. Press ENTER. 

10. Fit to View     

 

Reorder layers 

1. Drag Damper layer below Swingarm1. 
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Return the canvas to AutoCAD 

1. Select Return to AutoCAD.  

2. Select Save. 

3. The canvas reappears in AutoCAD. 

 

Exercise complete. Close drawing. No save required. 
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Exercise 11 – Cordless Drill 

The following exercise will have you illustrate a cordless drill. The process will use paint 

underlays, selection masks, layer duplication, and various brushes. 

 

Create the canvas and open in SBD.  

1. Launch AutoCAD. 

2. Open 11 – Cordless Drill.dwg. 

3. Select Layout1. 

4. Make the Canvas layer current. 

5. Use New Canvas, set the following values: 

a. Resolution = 96 

b. Create Vector Underlay OFF 

c. Create Paint Underlay ON 

d. Enable Transparent 

 

e. Select Apply 

NOTE:  AutoCAD will take a moment to plot the viewport to create the canvas image. 

6. After the background plot notice appears, select SketchBook Designer. 

NOTE:  AutoCAD will minimize and transfer the canvas image to SBD. 

  



Enhance AutoCAD
®
 Designs with Autodesk

®
 SketchBook

®
 Designer 

34 
 

Convert AutoCAD layer to SBD paint layer 

1. Select the Underlayer Layer. 

 

2. Select Convert to paint layer. 

 

3. Rename the Paint2 layer to Red. (double-click the layer name) 

    

Scale and position layer 

1. Select the Red layer. 

2. Select Scale. 

 

3. Scale the layer to approximately 40%. 

  

4. Press ENTER and then press ESC to set the scale and release the layer. 

Color the battery and drill chuck 
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1. Use Solid fill to color the battery black. 

    

2. Select Magic Wand (W). 

 

3. Select the area outside the drill. Note the blue mask and highlighted outline. 

   

4. Invert the selection by using the Edit menu or press Ctrl+Shift+I. 

  

5. Remove the drill body from the selection – press ALT and pick inside the drill body. 

  



Enhance AutoCAD
®
 Designs with Autodesk

®
 SketchBook

®
 Designer 

36 
 

    

6. Select the Air brush. Size = 15, Brush Intensity = 10.  

  

7. Zoom on the drill chuck. Use medium-gray to color the drill chuck. Add more color at the 

bottom to produce a shadow. 

  

8.  Use Deselect (Ctrl-D) to release the selection mask. Zoom to see full page. 

  

Color the power button, lock, battery release logo areas 

1. Use Magic Wand (W) to select the areas. Use Shift to select multiple areas. 

Use Solid fill and a bright red color. Note that all areas should simultaneous fill. 
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2. Deselect the selected areas. 

Duplicate, position, and rename layers 

1. Select the Red layer. From the Marking Menu select Duplicate layer. (Left-click on layer 

name and drag to layer option) 

   

2. Repeat Duplicate layer to create a third layer. Rename these new layers to Blue and 

Yellow. 

    

3. Select the Blue layer. Select the Scale tool. Drag the image to the left as shown. 

   

4. Repeat the process for the Yellow layer dragging it to the right as shown. 
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5. Zoom to see full page. 

Color the alternates 

1. Select the Blue layer. Use Magic Wand (W) to select the drill body. Color using a 

medium-blue with the Paint brush. Size = 5, Intensity = 20. Use white to add highlights. 

    

2. Deselect the selected areas. 

3. Select the Red layer. Use Magic Wand (W) to select the drill body. Use Marker and a 

medium-dark red. Use Eraser to create highlights. 

 

4. Deselect the selected areas. Repeat the process for the Yellow layer. Try Air brush. 

Size = 15, Intensity = 10. Begin with a medium yellow. Use a darker yellow for shadows. 
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5. Deselect the selected areas. 

6. Zoom actual size. 

 

Background 

1. Use the layer Marking Menu to create a new paint layer. Name the layer Background. 

  

2. Rotate the paper approximately 45 degrees. Use Fit to view to see the entire page. 
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3. Use Magic Wand to select an area outside of the drills. Select the Red layer and press 

Delete. Select the Blue layer and press Delete. Repeat for the Yellow layer. The white 

background should be erased. 

   

4. Use Paint brush to create the image as shown. Color = Black, Point = Medium, Size = 

50, Intensity = 10. 

    

5. Deselect the selected areas. 

 

Save custom background images so that they can be imported for reuse in 

other illustrations. 

 

6. Zoom Actual size to restore the paper rotation.    

7. Optionally, use selection masks and Delete to create clean edges. 
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Return to AutoCAD 

1. Select Return to AutoCAD. When prompted, Save the drawing. 

  

2. Since the image was scaled and copied in SBD, its appearance will be very different 

from the original drawing. The image below shows the canvas size edited after returning 

to AutoCAD. 

 

3. Delete the canvas from Layout1. 

4. Select Layout2. 

5. Select Portfolio to manage canvases in AutoCAD. 

 

6. Place the canvas to suit. 
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7. Optionally, use the SBD Layer tool to toggle the Background layer visibility. 

    

8. Close the drawing. No save required. 

Exercise 12 – Table 

The following exercise will have you illustrate a table. The main geometry will be illustrated from 

which a reflection will be created. Objects have been created in AutoCAD which will be used for 

vector underlays. 

 

Create the canvas and open in SBD 

1. Launch AutoCAD. 

2. Open 12 – Table.dwg. 

3. Select Layout1. 

4. Use New Canvas to create a canvas with properties: 

a. Resolution = 96 

b. Create Vector Underlay = ON 
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5. Select Apply. 

6. Select SketchBook Designer. 

Layer clean-up and conversion 

1. Select the VP layer. Use the Marking Menu to delete the layer. 

 

2. Select the Table layer. Use Convert to vector layer to allow layer editing in SBD. Note 

how the disabled layer (gray) is now enabled (blue). 

   

3. From the Woods and Tiles asset tab, use Linear fill. Use Solid fill for the peg. 

a. Legs = Woodbeach 

b. Top = Wood001 
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4. Create a new vector layer using the Marking Menu. Name it Floor. Set it as the active 

layer. 

   

5. From the Brushes asset, select the Soft Air brush. Set the Size = 300, Intensity = 30. 

  

6. Use the Polyline point mode to create a horizontal line. This line can be adjusted later. 

  

7. Use the Marking Menu to duplicate the Table layer. Rename Table1 to Reflection. 
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8. Select the Reflection layer. Select the Distort tool. Use the Flip and Y-Scale grips to 

change the image as shown below. The scale value used below was 0.50. 

  

 

9. Select the Reflection layer Properties. Adjust the Lightness to suit. 

 

 

Lightness = 54 

1. Drag the Floor layer below the Table layer. 
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2. The reflection should appear “behind” or “below” the table. 

 

3. Select the Reflection layer. Change Blend = Darken. 

  

4. Rename the layer Paint 1 to Shadow.  

5. Use Air brush to add a shadow below the table. Optionally use a selection mask to 

restrict the paint area. 
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10. Deselect any selected areas. 

11. Drag the Shadow layer below the Table layer. 

12. Optionally, “brighten the room.” Select the Canvas layer. Increase Opacity to suit. 

 

13. Select Return to AutoCAD. When prompted, Save the drawing. 

 



Enhance AutoCAD
®
 Designs with Autodesk

®
 SketchBook

®
 Designer 

48 
 

Exercise 13 – House Elevation View 

The following exercise will have you illustrate an elevation view of a house. The process will use 

paint underlays, selection masks, image importing, fills, layer folders, and layer blending. 

 

Create canvas and open SBD 

1. Launch AutoCAD. 

2. Open 13 – House Elevation.dwg. 

3. Select Layout1. 

 

The layout contains a viewport 

displaying the model space objects. 

 

4. Set Canvas layer current. 

5. New Canvas. 

a. Resolution = 96  

b. Create Vector Underlay ON 

c. Preserve Layers 

d. Transparent = Enable (checked) 

6. Apply.  

7. Go to SBD. 
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Delete VP layer and convert remaining AutoCAD layers to vector layers 

1. Delete the VP layer. 

2. Select layers WINDOWS, WALLS, ROOF, and GROUND. Convert to vector layers. 

     

Create a Sky background 

1. Create a new paint layer with the name Sky_Glass. Position above the Canvas layer. 

  

2. Select Solid fill, color = White, Sample all layers = Disabled (unchecked) 

   

3. Pick anywhere in the canvas area to color the Sky_Glass layer white. Press ENTER to 

accept. A white background should appear. 
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4. Use Magic Wand to pick the sky portion of the image. (Sky_Glass layer still active). 

Press Delete. 

    

5. From the Edit Menu, select Invert Selection (Ctrl+Shift+I). 

   

6. Select Convert Selection to Paint Mask. A paint mask layer will be created. 

 

   



Enhance AutoCAD
®
 Designs with Autodesk

®
 SketchBook

®
 Designer 

51 
 

7. Disable the paint mask layer. 

   

8. Select the Canvas layer. 

9. File menu > Import > Image (Ctrl+R). Select Sunset_violet.jpg. 

 

10. Use Scale tool (if it does not automatically launch) to scale and position on canvas. 

 

11. Press ENTER to accept. Press ESC. 

 

The imported Image is now clipped; to adjust will require deleting or erasing 

the layer and re-importing the background image. 

 

Create transparent windows 

1. Select the Sky_Glass layer. 
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2. Use Magic Wand to pick within a window. Press Shift key (Add mode) to select within 

remainder of windows. Use Alt key (Remove mode) as needed if extraneous areas are 

selected. 

 

3. Press Delete to erase the paint. The windows become “transparent”. 

 

DO NOT DESELECT OR CHANGE THE SELECTION. 

4. New Paint Layer, name it Glass.  

 

5. Linear fill, select Light Blue from the Ramps asset. Click and drag as suggested. 
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6. Add and adjust additional color controls along the ramp to suit. Press ENTER to accept. 

7. Expand the Glass layer Properties. Adjust opacity to about 50%. Press ENTER to 

accept. Note how the background is visible through the Glass layer. 

 

 

8. Deselect.  

 

Fill wall and roof objects 

1. Select WALLS layer. Texture Fill. Import, select limestone texture from Exercise folder. 

    

2. Fill to suit. Press ENTER to accept. 
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3. Texture Fill. Select Stucco from the Building material asset. 

 

4. Fill second wall to suit. Press ENTER to accept. 

 

5. Select ROOF layer. Fill, select a color from the wheel. Select an area within the roof 

objects. Press ENTER to accept. 
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Landscaping 

1. Select GROUND layer. Select Air Brush, Polyline, dark green color (grass), half-brush 

mode, size=200, Intensity=80. 

          

2. Pick on the horizontal line as shown. Adjust to suit. Press ENTER to accept. 

 

3. File menu > Import > Image (Ctrl+R). Select Tree_01.png. Use Scale tool to suit. 

  

4. Import other tree and shrub images from the Exercise folder. Use Scale tool to vary the 

images (size, x-scale, y-scale, horizontal flip, etc.). Use Import for each landscape 

element or use the layer duplicate tool. 
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Create folders 

1. From the Marking Menu select New layer folder. Name it Landscape. Drag and drop all 

of the landscape layer elements into the Landscape folder. 

   

 

Layer folders provide easy organization and management of similar layers. 

Toggle the layer folder visibility to affect all layers in the folder. Expand the 

folder to adjust individual layers. Layer folders also have property controls 

for opacity, blending, etc. 

 

2. Collapse the Landscape layer folder. 

Shadows 

1. Create a new paint layer, name it Shadow. Place it above the Landscape folder. 
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2. Enable the paint mask layer created earlier. 

  

 

The paint mask will prevent paint from going into the masked area, in this 

case, the sky / background. 

 

3. Use Air Brush to add shadows to suit. Disable paint mask when complete. 

 

Return to AutoCAD 

1. Save the drawing. 

2. Select Return to AutoCAD. 

3. Save and close the AutoCAD drawing. 
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CLASS SUMMARY 
Autodesk SketchBook Designer opens the door for designers to sketch concepts in a digital 

format to leverage these in the downstream design workflow. With its hybrid raster and vector 

tools, users can explore design concepts, annotate an AutoCAD drawing, or produce 

illustrations for more powerful visual communications. 

Visit the resources to watch SketchBook Designer in action and to communicate with others.  

 

Thank you for your time. I hoped you enjoyed the session. 
 

Jerry Berns 

Manufacturing Application Engineer 

EMA Design Automation, Inc. 

www.ema-eda.com 

jerryb@ema-eda.com 

 

TIPS 
 AutoCAD layers brought into SBD are not color locked. 

 AutoCAD Users, SBD uses an active mode in which a command or tool is active until 

cancelled. 

 Resetting assets (Custom Palette).  The Custom Palette saves its settings in a file 

named Default.ILS. This is stored in your roaming profile folder (Windows 7). 

 

If you need to reset or restore Assets to their default values, locate an original copy of 

the Default.ILS file in this folder:  

 
C:\Program Files\Autodesk\ApplicationPlugins\SketchBook Designer.bundle\Contents\AALSBin 

 

Close SketchBook Designer. 

 

Copy the file to your roaming folder (Window 7): 

 
C:\Users\YourProfileName\AppData\Roaming\Autodesk\SketchBookDesigner\2.0 

 

Open SBD to confirm the restore. 

 

 Backup custom palettes using the Export Assets feature. 

  

http://www.ema-eda.com/
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RESOURCES 
SketchBook Designer contains a useful Tour Guide available in the Help Menu. Review or 

discover tools and shortcuts from this hands-on lab.  

         

 

SBD 2012 – Getting Started Series: 

http://www.youtube.com/playlist?list=PL29B8315388946108 

Great video series on SBD basics. 

SketchBook Designer – Tips & Workflows: 

http://www.sketchbooknews.com/storage/downloads/SBD_2012_tips.pdf 

 

SketchBook News blog: 

http://www.sketchbooknews.com/ 

It covers most versions of the SketchBook product family. 

DaVinci blog: 

http://davinci-autodesk.typepad.com/blog/ 

SBD Forum at The Area: 

http://area.autodesk.com/forum/autodesk-sketchbook-pro/sketchbook-designer/ 

 

SHORTCUTS 
Undo Ctrl + Z 

Redo Ctrl + Shift + Z 

Select Curve V 

Select All Ctrl + A 

Deselect Ctrl + D or ESC 

Cycle Manipulator [momentarily]  (if option off in Preferences) Shift + Ctrl 

Snap lines while drawing point curves Shift + Alt 

http://www.youtube.com/playlist?list=PL29B8315388946108
http://www.sketchbooknews.com/storage/downloads/SBD_2012_tips.pdf
http://www.sketchbooknews.com/
http://davinci-autodesk.typepad.com/blog/
http://area.autodesk.com/forum/autodesk-sketchbook-pro/sketchbook-designer/

